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Research an environmental issue. Create 
pamphlets, posters, and brochures to 
raise awareness.

In this course, students become Earth Keepers. They raise environmental 

awareness about current issues. To start, they use the Internet to research facts 

and organize the information under headings in a Microsoft Word document. 

Next, they learn how to use the tools in Microsoft Publisher to create a 

postcard and a poster as a call to action. To inform people further about the 

importance of this issue, students use Microsoft Publisher to produce a 

pamphlet that describes the harmful effects and offers solutions. Optional 

activities have students prepare for an Environmental Conference by creating 

a calendar, banners, and invitation to the event. 
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Introduction 

Introduction 

This section provides valuable information about teaching 

TechnoEnvironment. It includes a description of the Teacher Guide, as well as 

an overview of the course. In addition, there are ideas for implementation and 

technology integration.  

 

For additional guidance, open the course in TechnoHub and select Get 

Started to access preparatory steps, resource list, and scheduling timetable. 
 

How to Use this Guide 

Course Overview 

Technology Integration Ideas 
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How to Use This Guide 

This Teacher Guide contains the following: 

Getting Started – This section contains a course description, as well as ideas for implementation. 

Course Instructions – The course is comprised of six sessions, each focused on a problem-solving 

task that aligns with the project theme. Each session includes assignments that break down the 

task into manageable steps. The components of each session are as follows: 

➢ Overview – An explanation of the session activities and their purpose.

➢ Materials – A list of handouts, sample files, templates, and teacher resource materials

needed to teach the session.

➢ Teaching Strategies – Instructional methods recommended for teaching the activities.

➢ Lesson Plan – A detailed list of each step in the session.

➢ Learning Objectives – A summary of the content knowledge and technical skills taught

throughout the session.

➢ Assignments – A session consists of assignments completed by students. Actions to be

performed on the computer by the student are indicated with a triangle ().

Background information is indicated with a dash (–).

➢ Review – A session review contains a list of fill-in-the-blank, multiple choice, or short-

answer questions intended to review Microsoft Office commands (answers included).

➢ Skill Review – An additional theme-related assignment intended to review publishing skills.

➢ Extension Activity – An additional activity that relates to the problem-solving task

presented in the session.

Appendices – This section contains additional information or materials including the following 

resources. 

➢ Skill Summary – A list of skills taught during this course.

➢ Glossary – A definition of each term.

➢ Contact Information – How to contact TechnoKids Inc. for curriculum support.
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TechnoEnvironment Overview 

In this course, students become Earth Keepers. They raise environmental 

awareness about current issues. To start, they use the Internet to research facts 

and organize the information under headings in a Microsoft Word document. 

Next, they learn how to use the tools in Microsoft Publisher to create a postcard 

and a poster as a call to action. To inform people further about the importance 

of this issue, students use Microsoft Publisher to produce a pamphlet that 

describes the harmful effects and offers solutions. Optional activities have students prepare for 

an Environmental Conference by creating a calendar, banners, and invitation to the event. 

 

➢ In Session 1, students research an environmental issue. To start, they learn about 

the importance of stewardship. Next, they select a topic and then design an 

outline in Microsoft Word with headings to organize facts. The Internet is used to 

locate information about the issue, including effects on the environment and 

solutions to the problem. Students record the source and gather pictures related 

to the topic. This research will provide the content for the publications they 

create in the following sessions. 

➢ In Session 2, students send a postcard to a friend asking them to become 

involved in protecting Earth. To prepare for this task, they are introduced to 

Microsoft Publisher. Once familiar with the parts of the window, a template is 

opened in the program. Students learn how to draw and format a shape to 

create a background for the front of the postcard. Next, they include a catchy 

title using a text box. To attract attention to the issue, a picture illustrating 

damage to the environment is inserted with a caption. A message is then written 

on the back of the postcard. 

➢ In Session 3, students create a help wanted poster to explain what people can 

do to protect Earth using facts collected during their research. To start, students 

insert a saved picture that illustrates the harmful effects of an environmental issue 

and apply their formatting skills. Next, they add an image from an online source 

and arrange it by adjusting the object order, alignment, grouping, and 

orientation. Afterwards, they use a Page Part to describe the problem and a 

solution that is achievable by students. A border is then inserted and an 

advertisement building block is used to request help. To complete the poster, a 

WordArt title is used to attract attention to the publication. 

➢ In Session 4, students begin to create a pamphlet to educate the public about 

an environmental issue. Using a template, students apply design elements 

including frames to accent each panel, a Page Part to create an attractive front 

cover, and text boxes to hold information. Once the layout of the pamphlet has 

been established, students apply their knowledge to produce the first panel in 

the publication. 

➢ In Session 5, students continue working on the pamphlet by proposing solutions to 

the environmental issue. The three panels of the second page of the pamphlet 

are completed using bulleted text, pictures, captions, and predesigned attention 

getters. On the third panel, students learn to add and format a table to compare 

the advantages and disadvantages of a solution to the environmental problem. 

➢ In Session 6, students complete the pamphlet. To inspire active involvement, the 

back of the pamphlet has a quiz. As viewers read the questions and answer 

them, they will remember information about the environmental issue and possibly 

even read the facts over again. The pamphlet will have achieved its aim of 

informing others and gathering support to face a very important challenge for 

Earth. 
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Technology Integration Ideas 

TechnoEnvironment is a cross-curricular unit that integrates technology into curriculum. In this 

course, students become environmental stewards. They raise awareness about environmental 

issues. The activities blend technology into geography, science, language arts, and visual arts. 

Lessons are ideal for middle and high school students.  

Below are some suggestions for implementing TechnoEnvironment: 

• Microsoft or Computer Applications Course: Teach TechnoEnvironment as part of a

technology course. The activities target Internet research and desktop publishing skills.

Students gain expertise with creating publications such as postcards, posters, and

pamphlets using Microsoft Publisher. Extension activities extend learning to produce a

calendar, banner, and greeting card.

• Environmental Curriculum Unit: This course integrates into any geography, science, or

social studies unit related to conservation, endangered species, or natural resources.  By

creating a series of publications about an environmental topic, students explore the

connection been human activity and the natural world. They summarize information

about the cause, harmful effects, and solutions to a problem. This investigation fosters an

understanding of the importance of stewardship and sustainability.

• Earth Day Workshop: TechnoEnvironment includes 15 fact cards. Use them to quickly

research a topic. Afterwards, select one of the activities such as the postcard or poster to

complete. Alternatively, select an extension activity from Sessions 3-5 to learn about

plastic pollution, fuel emissions, or water conservation.

• Environmental Conference: Host an event. In this course, students gain expertise about

an environmental topic. Have them produce one or all the publications: postcard,

poster, and pamphlet. Afterwards, they can share their knowledge in a brief presentation

using a TED talk format using their publications as a visual aid. Consider using the

Session 3-5 Extension Activities to promote the event (calendar banner, card).

• Language Arts Class: An emphasis in TechnoEnvironment is on research and

communication skills. Support is given to boost students’ search strategies, ability to

organize data, and persuasive writing techniques. Interwoven throughout the activities

are hints to convey a simplified message by combining text and images effectively.

• Visual Arts Class: Target visual arts learning outcomes with TechnoEnvironment. Graphic

design is an important element of the lessons. Students apply their creativity to organize

information and arrange content.



 

 

This is a preview of the teacher guide. 

Pages have been omitted. 
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Session 4 Educate the Public 

In this session, students begin to create a pamphlet that will educate the public 

about an environmental issue. To start, they review a sample to gain an 

understanding of the content and design of the publication. Once familiar with 

the task, they open a template, insert a border, and set the color scheme. Text 

boxes are then inserted into specific panels in preparation of information being 

added in the following session. Once the layout of the pamphlet has been 

established, students use a Page Part to create an attractive front cover and 

add content to the first panel. 

Together we can save the Earth. Plan to spread the word. 

Assignment 9: Design the Layout for a Pamphlet 

Assignment 10: Explain the Environmental Issue 

Session 4 Skill Review: Stand Up to Drive Less 

Session 4 Extension Activity: Create a Banner 
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Session 4 Getting Started 

Overview 

 

In this session, students begin to create a pamphlet that will educate the public about an 

environmental issue. To start, they review a sample to gain an understanding of the content and 

design of the publication. Once familiar with the task, they open a template, insert a border, 

and set the color scheme. Text boxes are then inserted into specific panels in preparation of 

information being added in the following session. Once the layout of the pamphlet has been 

established, students use a Page Part to create an attractive front cover and add content to 

the first panel. 

 

Materials 

• Microsoft Publisher 

• Environment Folder 

o Pamphlet Sample 

o Pamphlet Template 

• Research sheet created in Session 1 

• Pictures saved in Session 1 

• Assessment 

o Pamphlet Marking Sheet (Optional) 

• Session 4 Skill Review (Optional) 

o Fuel Emissions folder 

o Standing Pamphlet Template 

o Emissions Pamphlet sample file 

 

Teacher Preparation 
(Refer to the Prepare to Teach section of this course for instructions) 

• Download the Tool Summary and/or Flashcards from TechnoHub. (Optional) 

 

Teaching Strategy 

 

In this session, students start to create a pamphlet about environmental issues. Explain scenario 

to students. 

 

In this session, you will begin to design a pamphlet to inform others about 

an important environmental issue. The pamphlet is a single sheet, double 

sided pamphlet that tells people about the problem, its harmful effects, 

and possible solutions. The words and pictures in the pamphlet urge 

people to get involved. In this session, you will set up the layout of the 

panels, choose a predesigned border, create the cover, and write the 

information on the first panel.  

https://technohub.technokids.com/
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Assignment 9: Design the Layout for a Pamphlet 

In this assignment, students begin to design an information pamphlet about an environmental 

issue. To start, they review a sample publication to gain an understanding of the task. Next, they 

insert a border, set the color scheme, and arrange text boxes to layout the framework. Once this 

is complete, students use a Page Part to produce the front cover. 

About the Pamphlet: 

Tips: 

• Print a Sample Pamphlet: Print a copy of the sample pamphlet so the students can see

and understand how a threefold pamphlet is constructed. Print the two pages of the

publication and glue or tape them with the blank sides together. (If you have a printer

that is capable of printing on both sides of the paper, choose this option to print the

entire publication on one page and omit the taping step). Next, fold the pamphlet. Using

the dashed guidelines on the outside of the template, fold the right panel first and then

fold the left panel to place the cover on the front of the pamphlet.

• Verify the Page: Caution students to check the Page Navigation pane to ensure that

they are working on the correct page and corresponding panel for each element

added so the pamphlet prints and folds correctly when completed.

• Simple Design: Encourage students to use a simple frame or bar when applying a border.

This will give them more room to add information and pictures.

Adjust Content Based on Time: If time is an issue follow these guidelines… 

o Complete Assignments 9-11 only. In these assignments, students describe the cause,

harmful effects, interesting facts, and solutions.

o Assignment 12 is a table that compares the advantages and disadvantages of one

solution. It is a more complex task. On this panel have students use their creativity to

include other facts or images instead.

o Assignment 13 is a quiz. This can be challenging as some students struggle to

generate questions. On this panel have students write their name, class name, and

other relevant details. Alternatively, have them list the top three sources of

information they recommend to readers based on their research in Assignment 2.

Assignment 10: Explain the Environmental Issue 

In this assignment, create the first panel of the pamphlet. It includes a description and cause of 

the environmental issue, bulleted list of interesting facts, and a picture with a caption. 

Encourage students to use their skills to format the text and pictures to create a professional-

looking publication. 

Page 2

Inside of Pamphlet

Page 1 

Outside of Pamphlet

Causes and 

Interesting Facts 

Assignment 10 

Quiz 

Assignment 13

Cover Page 

Assignment 9

Harmful Effects 

Assignment 11

Solutions 

Assignment 11
Advantages and 

Disadvantages of a Solution 

Assignment 12
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Lesson Plan 

 

Assignment 9: Design the Layout for a Pamphlet 

• View a sample pamphlet and answer questions. 

• Open the pamphlet template. 

• Insert a border to frame each panel and align the frames or bars. 

• Group the border and copy it to the second page of the pamphlet. 

• Apply a color and font scheme to the pamphlet. 

• Insert text boxes with a heading to design a template. 

• Create the front cover of the pamphlet: 

o Insert a Page Part on the right panel of Page 1. 

o Replace the picture in the Page Part with a saved picture. 

o Replace the title with the Environmental Issue Topic. 

o Replace caption text with a call to action. 

• Save the pamphlet and exit Microsoft Publisher. 

 

Assignment 10: Explain the Environmental Issue 

• Open the saved pamphlet. 

• Describe the issue: 

o In the left panel of Page 1, replace Heading with What is Environmental Issue? 

o Describe the environmental issue and causes. 

• List interesting facts: 

o In the left panel of Page 1, type the heading Interesting Facts. 

o Use Format Painter to copy formatting from the first heading to the second heading. 

o Type interesting Facts. 

o Select the facts. Apply a bullet style. 

• Insert a picture and format the picture. 

• Insert a caption describing the picture. 

• Save the pamphlet and close Microsoft Publisher. 

 

  

Stand Up to Drive Less: If your instructional time is limited consider completing this task in place of the 

tri-fold pamphlet designed in Assignments 9-14. This activity is also ideal if learning about fuel emissions 

in a science or social studies class. 

 

Create a Banner: If you plan on sharing student work in an Environmental Conference at the end of 

the unit, hang banners to decorate the room. 
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Learning Objectives 

Content Knowledge: 

• understand a pamphlet promotes interest in an issue and advocates action

• demonstrate an understanding of the parts of a two-sided threefold pamphlet

• identify effective design elements on a sample pamphlet

• communicate the causes of an environmental problem

• communicate the harmful effects of an environmental issue using words and pictures

Operating Environment 

• open and close a program

• open a saved publication

• save a publication

• use the navigation pane to view pages in a publication

Graphics 

About Objects 

• align objects relative to guidelines, boundaries, or another object

• scale, move, or skew an object

• group objects

• copy and paste objects

About Pictures 

• insert a picture from a file or online

• apply a picture style

• customize the color, weight, and dash style of the picture border

• add a caption to a picture

About Building Blocks 

• insert a page border

• insert a Page Part

• change the picture in the Page Part and customize the text

• insert an Advertisement that grabs attention

About Page Design 

• apply a color scheme

Desktop Publishing 

• illustrate the environmental issue using appropriate pictures

• insert a caption that explains the picture

• format objects with color and design elements that suit the topic

• arrange elements to create an appealing and balanced layout

• format the title to attract attention and make it easy to read

• apply a border to frame the information

• list information using bullets to improve readability

• divide information into logical sections

• organize information using headings

Word Processing 

• draw a text box

• enter, select, and delete text in a text box

• format the font, style, and size

• automatically resize text to fit the size of the text box

• copy formatting from a selection of text to another

• bullet a list

Applied Technology 

• use a template to create the front cover and first panel of a pamphlet about an

environmental issue
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Assignment 9 Design the Layout for a Pamphlet 

People need to be informed about environmental issues. To raise 

awareness, you will make a pamphlet to educate others. The pamphlet 

will contain a description of the issue, causes, harmful effects, and 

solutions. To start, you will study a sample to get ideas. Afterwards, you will 

begin construction of your own publication by laying out the design.  

 

View a Sample Pamphlet and Answer the Questions 

 

1. Open the Pamphlet Sample. (Ask your teacher where this is located.) 

• The pamphlet is divided into panels. 

• Each panel holds different types of information. 

• In Publisher, the pamphlet is organized on two pages. 

• The pages are to be glued together and folded to make a tri-fold pamphlet. 
 

 

 

 
Panel 2 

Inside Flap 

Panel 3 
Back Cover 

Panel 1 
Front Cover 

 

Panel 4 
Inside Left Panel 

Panel 5 
Inside Center Panel 

Panel 6 
Inside Right Panel 

 

2. About Page 1: 

 a. Panel 1 is the front cover of the pamphlet. It uses a Page Part to describe the 

environmental issue.  
 

What is the title of the pamphlet?  

  Acid Rain 
   

 b. Panel 2 is the inside flap of the pamphlet. It is what people will read first. It includes a 

description of the issue, causes, and interesting facts. It also has a picture.  
 

What is the caption for the picture? 

  Diagram showing the cause of acid rain. 
   

 c. Panel 3 is the back cover of the pamphlet. It includes a quiz about the topic.  
 

Why is it a good idea to include a quiz? 

  A quiz makes people read the information in the pamphlet and think about it. 
   

3. About Page 2: 

 a. Panel 4 is the inside left panel. What information is on this panel?  

  Harmful effects 
   

 b. Panel 5 is the inside center panel. What information is on this panel? 

  Solutions 
   

 c. Panel 6 is the inside right panel. It describes in detail a solution using a table.  

List the table headings. 
 

  Advantages  Disadvantages 
 

4. Close the pamphlet sample. 
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Open the Pamphlet Template 

5.  Open the Pamphlet Template. (Ask your teacher where this is located.)

 If you cannot see the guidelines, from the View tab, tick the Guides check box.

Select a Border to Frame the Pamphlet 

6. a. Pick a border:

 From the Insert tab, select Borders & Accents.

 Select a bar or frame from the gallery.

 Use the guidelines to place the frame:

o If using a frame, resize the border to fit inside the guides for the LEFT panel.

o If using a bar, stretch it between the left and right boundaries. Align the bar

to the TOP blue guide across all panels.

b. Copy the border to frame each panel:

 Select the border. Right click on the border and select Copy.

 Right click again and select Paste.

o If using a frame, drag the border into the CENTER panel. Select Paste again

to insert a third panel into the RIGHT panel.

o If using a bar, drag the object to align it to the bottom blue boundary.

Page 1 

Page 2 

Guidelines outline 

the margins of the 

three panels of the 

pamphlet. 

Dotted lines show fold 

lines for the outside of 

the pamphlet. 

Pick a border with 

narrow lines. You will 

have more room to 

place the pictures 

and facts. 
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Arrange the Border on Each Page 

 

7. a. Align the borders: 

   Select all borders on the page by holding the SHIFT key and clicking on each object. 

   From the Drawing Tools Format tab select Align Objects.  

   If the options are greyed out, select Relative to Margin Guides.  

   Click Align Objects again.  

  
o Select Align Top  if there are three frames. 

o Select Align Center  if there are two bars. 

  

 
 

 b. Group the border and copy to Page 2: 

   Select all borders on the page by holding the SHIFT key and clicking on each object. 

   From the Drawing Tools Format tab, select Group.  

   Right click on the grouped object and select Copy.  

   Click Page 2 in the Page Navigation pane. 

  

 

   Right click the mouse and select Paste.  

   Apply your skills to align the borders on the page.  

 

Apply a Color and Font Scheme 

 

8. a. Pick a color scheme to set the palette: 

 
  Click the Page Design tab. 

 
  Select a color palette from the Schemes group. 

 

 

 
 

 
b. Click Scheme Fonts and pick an option that is easy to read.  

  

The font scheme sets the typeface for objects such as Page Parts.  

Do not worry about the color. 

You are changing it soon. 
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Add Text Boxes onto Each Page to Design a Template 

You will use text boxes to add content to the pamphlet. You will create one text box and then 

copy and paste it to fill other panels. This is a quick way to create a consistent layout.  

9. a. Make a text box that you will copy into each panel:

 View Page 2.

 Draw a text box that fills the LEFT panel.

 Type Heading. Press ENTER.

 Use the commands on the Text Box Tools Format tab to format the heading:

o Select a font.

o Apply a bold style.

o Set the font size to 14.

b. Copy the text box into each panel to create a template:

 Right click the text box and select Copy.

 Right click again and select Paste.

 Position the text box in the CENTER panel.

c. Align the text boxes to each other:

 Click on one text box. Hold the SHIFT key and click on the other text box.

 From the Drawing Tools Format tab click Align Objects.

 Deselect Relative to Margin Guides.

 Click Align Objects again.

 Select Align Top

d. Paste a text box onto Page 1:

 View Page 1.

 Right click and select Paste.

 Position the text box in the LEFT panel.

DO NOT place a text box in the other 

panels. A quiz will be placed into the 

center panel and a Page Part will be 

placed into the right panel. 

DO NOT place a text box in the RIGHT 

panel of Page 2 because a table will be 

in that panel instead. 
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Create the Front Cover of the Pamphlet 

 

You are going to use a Page Part to create the front cover of the pamphlet. It will include a title, 

call to action, and picture. 

 

10. a. Insert a Page Part: 

 
  View Page 1.  

 
  From the Insert tab, select Page Parts.  

 
  Pick an option that has a picture, title, and caption. 

 
  Place the Page Part on the RIGHT panel of Page 1. Resize it to fit inside the guides. 

 

 
 

 b. Add a title: 

   In the Title box, type Topic Name. 

   Resize the text to fit the box.  

   If there is a Subtitle, replace the text with Be an Earth Keeper. 
   

 c. Replace the Caption text with a message that will draw interest.  For example: 

  

o We need to solve this problem before it is too late. 

o Learn more about this important environmental issue. 

o You can make a difference! 

   Resize the text to fit the box.  Adjust the alignment.  

 

 d. Change the picture(s): 

   Double click on a picture to select it.  

   From the Picture Tools Format tab, click Change Picture.  Select Change Picture. 

   Go to the place where you saved your pictures in Assignment 4.  

   Select the picture you want. Click Insert. 

   Repeat the steps if there are additional pictures in the Page Part. 
 

 

Save the Pamphlet and Exit Publisher 

HINTS AND TIPS 
 

• To change the part of the picture in view, click Crop.   Drag the image 

inside the frame.  

• If a picture is cropped, but you want the whole image, click Fit.  

• To swap an image, you can drag a picture from the Scratch Area into a 

picture placeholder. 
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Assignment 10 Explain the Environmental Issue 

Once you have the viewers' attention with a powerful pamphlet cover, you 

must educate them about the environmental issue. Do this on the next 

panel they will see as they unfold the pamphlet.  

Use the skills you have learned making the postcard and poster, as well as 

the facts on your research sheet, to inform viewers about the problem. 

Describe the Environmental Issue 

1. Open the pamphlet into Microsoft Publisher.

2.  View Page 1.

 Replace Heading on the LEFT panel of Page 1 with What is Environmental Issue?

 Below the heading, describe the environmental issue.

Add Interesting Facts Heading 

3. a. Add a heading in the LEFT panel:

 Position the cursor below the paragraph describing the environmental issue.

 Type Interesting Facts or Did you Know? Press ENTER.

b. Copy the formatting from one heading to another:

 Place the cursor in the heading What is Environmental Issue?

 On the Home tab, click Format Painter.

 When the cursor turns into a brush , drag across Interesting Facts. 

✓ Refer to the Definition and the Causes sections of the research

sheet to explain the issue.

✓ Use words that will be easy for a fellow student to understand.

✓ Be sure to change the information into YOUR OWN WORDS.

Are there hyphens in the text? 

To remove the hyphen: 

1. Select the text.

2. From the Text Box Tools Format tab,

click Hyphenation.

3. Remove check from Automatically

hyphenate this story.

4. Click OK.
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List Interesting Facts using Bullets 

 

4. a. Add interesting facts: 

 
  Refer to the research sheet to locate interesting facts.  

 
  In your own words, type at least two Interesting Facts. Press ENTER after each fact. 

   

 
b. Bullet the list: 

 
  Select the facts. 

 
  On the Home tab, click Bullets.  

 
  Pick a bullet style. 

 

   
 

Insert a Picture with a Caption 

 

5. a. Insert a picture: 

 
  From the Insert tab, click Pictures.  

 
  Select a picture about the environmental issue you saved in Assignment 4. 

 
  Place the picture in the LEFT panel.  

 
  Format the picture style.    

   

 
b. Add a caption: 

   From the Picture Tools Format tab, click Caption.  

   Select an option from the gallery. 

   Type a description of the picture.  

   

 
c. Move  or resize  the picture to place it in the LEFT panel. 

 

 

Save the Pamphlet and Exit Publisher 

 

To see more styles: 

1. Select Bullets and Numbering. 

2. Click Character.  

3. Click the Font arrow. Pick Wingdings or Webdings.  

4. Pick a symbol. Click OK. Click OK again. 

HINTS AND TIPS 
 

• Press ENTER to create white space and divide information. 

• Click Text Fit and pick Best Fit to resize text to fit in the box.  

• Keep the caption brief. 

• If you do not like the caption style, pick another one.   

The existing text will be placed into the new caption box. 

• Use a different picture then you used on the front cover.  

If you do not have one, search online.  
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Session 4 Skill Review: Stand Up to Drive Less 

Read the information and then follow the instructions on the next page to create a pamphlet. 

Before getting started you will need the Standing Pamphlet Template and the Fuel Emissions 

folder. Ask your teacher for these files. 

What are Fuel Emissions? 

Cars and trucks use fuel to drive. 

A car engine burns the fuel to 

produce energy to make the 

car move. This process 

produces emissions. Fuel 

emissions are fumes released 

into the air from a car's exhaust. 

The emissions contain harmful 

chemicals such as 

hydrocarbons, carbon 

monoxide, carbon dioxide, and 

nitrogen oxides. 

Interesting Facts 

• There are hundreds of millions

of cars on the world’s roads.

• Cold engines pollute up to

five times more than warm

ones. Link errands together in

one trip to minimize "cold

starts".

• Car exhaust creates pollution

at ground level where people

are walking.

• Car idling pollutes the air. Turn

off the car when it is not

being driven in traffic.

• The more fuel efficient a

vehicle, the less carbon

dioxide it emits.

• Fuel emissions produce

ground-level ozone.

Fuel emissions contain harmful chemicals such as 
hydrocarbons, carbon dioxide, and nitrogen oxides. 

Harmful Effects 

• Smog: Emissions from cars contribute to smog. Smog is smoky fog

that becomes visible when sunlight shines on polluted particles.

Smog can cause asthma attacks, headaches, burning eyes, itchy

throat, and cough.

• Respiratory Illness: Car emissions pollute the air we breathe. Polluted

air can contribute to diseases such as asthma, bronchitis, and

emphysema.

• Global Warming: Carbon dioxide emitted from cars is a greenhouse

gas that contributes to global warming. Global warming is an

increase in the temperature of the Earth’s atmosphere.

• Climate Change: Fuel emissions contribute to global warming. It is

believed that global warming will alter weather patterns. Climate

change will cause rising sea levels, flooding, melting of polar ice

caps and glaciers, heat waves, forest fires, and increased rain or

drought.

Solutions 

• Be Active: Walk, bicycle, skateboard, or rollerblade.

• Mass Transit: Take transportation that carries many

people such as the bus, trolley, subway, or ferry.

• Carpool: Arrange to drive with someone, instead of

taking two separate vehicles.

• Clean Automotive Technology: Develop new engine

and drive train technologies that reduce emissions.

• Electric Car: Drive battery powered cars that plug into

an electric outlet to recharge.

• Hybrid Car: Drive cars that use both electric and

petroleum fuel as a power source.

• Alternative Fuels: Develop new fuel sources such as

biodiesel, ethanol, hydrogen, or natural gas. Ethanol is

a biofuel made from plants. Plant sources include

hemp, soya, corn, sugar cane, wheat, and sugar

beets.

Biofuel 
An examination of an alternative solution to 

reduce fuel emissions. 

Advantages Disadvantages 

Fuel comes from crops 

that are grown by 

local farmers. 

The source of the fuel is 

renewable. 

Produce less harmful 

emissions. 

Biofuels can run a car 

with little or no change 

to the engine or fuel 

system. 

Biofuel refineries are 

more environmentally 

friendly than oil 

refineries. 

Risk food shortages if 

grow crops for fuel 

instead of food. 

Fertilizer used to grow 

crops can leak into the 

water and cause 

algae blooms. 

Water is used to grow 

the crops, which can 

stress water supply. 

More petroleum fuel is 

used to farm and 

transport the crop than 

is created into biofuel. 
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Create a pamphlet that informs others about fuel emissions. 
 

1. Open the Standing Pamphlet Template in Microsoft Publisher.  

2. From the Page Design tab, select a color scheme.  

3. Insert bars to frame the page: 

 a. From the Insert tab, choose Borders & Accents . Select a bar.  

 b. Resize the bar to stretch from one EDGE of the page to the other. 

 c. Position the bar to fit below the top blue boundary. 
   

4. a. Select the bar. Right click and select Copy.  

 b. Right click on the page and select Paste.  

 c. Position the bar to fit above the bottom blue boundary. 
  

5. Introduce the topic in the LEFT panel: 

 a. Insert a Page Part.  Choose a Page Part that has a picture and text. 

 b. Change the picture(s) using pictures in the Fuel Emissions folder.  

 c. Replace the Title with Drive Less. 

 d. If there is a Subtitle, change it to Save the Planet.  

 e. Replace the Caption with By Student Name. 
  

6. Describe the issue in the CENTER panel: 

 a. Insert a text box.   

 b. Type the heading What are Fuel Emissions? 

 c. Format the text to make it look good.      

 d. Read the fact sheet. Type a brief description about fuel emissions. 
   

7. a. Type the heading What Can You Do to Help?  

 b. Refer to the Solutions section on the fact sheet. List two solutions. 

 c. Create a bulleted list . 

 
 

Tip: To select a custom bullet, select Bullets and Numbering at the bottom of the Bullets gallery. Click 

Character. Click the Font arrow and select Webdings or Wingdings. Pick a symbol. Click OK twice. 

 d. To format the text, click Text Fit.  Select Best Fit.  
  

8. List interesting facts in the RIGHT panel: 

 a. Insert a text box.  Type the heading Interesting Facts.  

 b. Refer to the Interesting Facts section on the fact sheet. List two facts. 

 c. Create a bulleted list . 
  

9. a. Insert a picture  from the Fuel Emissions folder.  

 b. Add a caption that describes the picture.   
  

10. Save the file as drive less. Print the pamphlet. Exit Microsoft Publisher. 
  

11. Fold along the dotted lines. Tape the ends together to make it stand up. 
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Session 4 Extension Activity: Create a Banner 

Another way to draw attention to your environmental issue and ask for help is to make a banner. 

Use your skills to design a sign that stretches over two pages. Glue or tape the sheets together 

and hang it in a place where people will notice it. 

Before getting started you will need the Banner Template. Ask your teacher for this file. 

1. Open the Banner Template in Microsoft Publisher.

The banner shows as one page 

on the screen. The design will 

be cut in the middle to print 

onto two pages.  

2. Pick a color scheme from the Page Design tab.

3. Draw a text box  or use WordArt  to write a Title or Call to Action. 

4. Decorate the banner using your skills:

• Add pictures such as photos or clip art.

• Insert Page Parts to include text.

• Frame the banner with a Border & Accents.

• Grab attention with Advertisements.

5. Save the document as banner.

6. Click File and select Print:

a. Under Layout Options, choose Letter and Landscape.

b. In the Print Preview window, check that the banner will print on two pages.

Check where the break will be 

when the banner prints. If it divides 

a word or image, you may want to 

move the object on the page. 

c. Click Print.

7. Cut the margin off one sheet and fasten the two pages together to form a banner.



 

 

This is a preview of the teacher guide. 

Pages have been omitted. 
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Session 6 Take an Environmental Quiz 

In this session, students complete the pamphlet. To inspire active involvement, 

the back of the pamphlet has a quiz. As viewers read the questions and answer 

them, they will remember information about the environmental issue and 

possibly even read the facts over again. The pamphlet will have achieved its 

aim of informing others and gathering support to face a very important 

challenge for Earth. 

Test yourself! What have you learned about the environment? 

Assignment 13: Design a Quiz 

Assignment 14: Edit and Print the Publication 

Session 6 Review: Microsoft Publisher Review 

Session 6 Extension Activity: Plan an Environment Conference or "TED" Talk 
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Pages have been omitted. 
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Complete the Pamphlet Checklist 

3. Check each item in the list to make sure your pamphlet is ready to print.

Pamphlet Content 

front cover attracts attention and introduces the environmental issue 

information includes causes, harmful effects, solutions, and interesting facts 

pictures have captions that describe the image 

comparison table outlines advantages and disadvantages of a solution 

quiz includes four multiple choice questions about the topic 

facts have been put into your own words 

text is free of spelling errors 

Pamphlet Design 

information is divided logically onto separate panels 

borders frame the information 

images and other design elements relate to the text 

page parts, WordArt, and attention getters emphasize facts and attract attention 

headings clearly identify the information and are formatted to stand out 

bullets are used to list facts and the symbol suits the information 

color scheme suits the topic 

text and image formatting are consistent and enhance the message 

Print the Pamphlet 

4.  From the File tab, click Print.

 Check that Print All Pages is selected under Settings.

TIP: If you have a printer that can duplex print, choose Print on Both Sides.

 Click Print.

Assemble the Postcard 

5.  Using tape or glue, fasten the two blank sides of the printed pamphlet together.

 Fold the pamphlet:

o With Page 2 facing you, fold the RIGHT panel over the CENTER panel.

o Use the dotted lines on Page 1 as a guide to folding.

o Now fold the LEFT panel over top.

o The cover of the pamphlet should be at the front or facing you.

Save the Pamphlet and Exit Publisher 
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